
 

What’s new in ArcGIS Business Analyst Web App — November 2024 release 

The November 2024 update of ArcGIS Business Analyst Web App includes data updates, a new cross-
border European data source, redesigned benchmark comparisons workflow, improved points of interest 
(POI) search workflow, enhancements to Business Analyst Assistant (Beta) capabilities, and new school 
district boundaries. 
 

New features summary 
Press Ctrl + click on a topic to jump to that section. Or, use the document’s internal table of contents by 
clicking View > Navigation. 
 

• Data updates 
• New Europe (Beta) data source 
• Redesigned benchmark comparisons workflow 
• Improved points of interest (POI) search workflow 
• Smart map search enhancements 
• New infographics 
• Important changes 
• Enhanced Business Analyst Assistant (Beta) capabilities 
• New school district boundaries 
• Improved accessibility  
• Deprecation notices 
• Updates to ArcGIS Experience Builder Business Analyst widget  
• Updates to ArcGIS Business Analyst Mobile App 
• Blog article resources  

 

Data updates 

U.S. data updates 

For this release, the U.S. data updates include: 
• New school district boundaries are available in mapping and analysis workflows. For more 

information, see New school district boundaries. (Press Ctrl + click to jump to that section.) 
• Esri has created a nationwide Urbanicity dataset that classifies geographies in the U.S. based on 

characteristics such as density, infrastructure development, and socioeconomic dependence on 
urban cores. Urbanicity is often defined as the degree to which an area is considered urban or rural, 
ranging from highly urban environments (city centers) to rural settings. Esri’s new Urbanicity 
classification system is comprised of 10 categories, built at the census block level and aggregated to 
larger geographic areas. 

• The Esri Business Summary dataset is now updated three times per year. There are 14 new 
categories of businesses, each with three variables. 

• Traffic count data is updated to 2024 Q3 from Kalibrate.  
 
  



Global data updates 

For this release, the global data updates include: 
• The Esri Standard Demographics dataset provided by Esri and Michael Bauer Research (MBR) has 

been updated for several countries in South America and Oceania. 
o In South America, the following countries have updated data: Argentina, Bolivia, Brazil, Chile, 

Colombia, Ecuador, French Guiana, Guyana, Peru, Paraguay, Uruguay, Venezuela. 
o In Oceania, the following countries have updated data: Australia, Fiji, French Polynesia, New 

Caledonia, New Zealand, Papua New Guinea. 
• The Esri Advanced Demographics dataset includes updates for: 

o Data for Canada has been updated to 2024 estimates, provided by Environics Analytics. 
o The Esri India data source has been updated. 

 

Other data updates 

• For the first time in Business Analyst Web App, there is a cross-border data source, Europe (Beta). 
This data source combines 39 countries into one group. For more information, see New Europe 
(Beta) data source. (Press Ctrl + click to jump to that section.) 

• Points of interest data (POI) from Data Axle (June 2024) for U.S. and Canada. 
• Points of interest data (POI) from SafeGraph (August 2024) for U.S., Canada, and Puerto Rico. 
• The Netherlands (4orange) data source is being retired in this release. 
• The Esri Tapestry Segmentation dataset is being reimagined. To participate in an Early Adopter 

Program (EAP), sign-up using this form: https://arcg.is/1i0iTT  
 

New Europe (Beta) data source 
Use the Data source drop-down menu to select the new Europe (Beta) data source. 
 

 
 
This is the first cross-border data source in Business Analyst Web App, combining thirty-nine European 
countries into one group. You can create maps, run reports, and perform analyses that span country 
borders. This new aggregated data source provides a broad variety of sociodemographic and consumer 
data using sixty-five indicators.  
 
To facilitate comparison, this data source includes: 

• Currency values are in euros (€) to facilitate cross-border comparisons. 
• Data are available on internationally comparable geographical levels and hexagon grids.  
• Data are compiled on administrative, postcode, and micro levels compatible to existing available 

boundaries.  
• Two new Standard infographics designed for cross-border analysis. 

 
Note: 
Since this is an initial beta release of a European regional data source, the data and boundaries are subject 
to change in future releases. 
 
In the upcoming release, ArcGIS Online has added a new organizational setting that allows administrators 
to control user access to beta features. In order to see the Europe (Beta) data source in Business Analyst 
Web App, this setting must be enabled at the ArcGIS Online organization level.  
 

https://arcg.is/1i0iTT


This setting can be found under Security tab in the Apps section. Turn off the Block Esri apps while they 
are in beta toggle button to enable members to access beta capabilities.  
 

 
 

Redesigned benchmark comparisons workflow 
The new benchmark comparisons workflow replaces the existing comparison reports. On the Maps tab, 
click Run analysis and click Benchmark comparisons. 
 

 
 
The previous functionality for comparison reports has been integrated and improved upon. For example, 
the Esri report templates that were included with comparison reports have been updated and are available 
to use as Featured and Industry lists. We are continuing to work to streamline our designs for ease of use 
across workflows, including providing the Results pane with quick analysis, statistics, and visualizations.  
 
Note: 
This new workflow is included with both Standard and Advanced licenses. 

 
The reimagined benchmark comparisons workflow includes the following enhancements. (Press Ctrl + click 
to jump to that section.) 

• Mapping workflow 
• New comparison methods 
• Results pane 

o Summary tab 
o In-app documentation 
o Histogram tab 
o Bubble chart or scatterplot tab 
o Table tab 



o Compare with geographies 
• Improved exporting to Excel 
• Save layer 
• Set preferences 
• Messaging 
• Custom and shared reports 
• Credits 

 

Mapping workflow 

Benchmark comparisons is an analysis workflow with mapping capabilities. Now you can view your 
comparison results while visualizing the features on the map at the same time. The first steps in this 
workflow—setting a geography and selecting a variable list—match the recently updated suitability analysis 
workflow. This workflow can be used with geographies or hexagons without the need to first create sites. 
Up to 10,000 features can be compared at the same time.  
 

• If you are using sites, use the Sites section to add, remove, or change the site selections. Use the 
Expand rings, drive times, and walk times toggle button to show the site area around the point. 

• In the Variables section, click Variables to add variables from the data browser or remove a variable 
from the analysis. 

• In the Statistics section, use the toggle buttons to enable statistical measures. The statistical 
measures are automatically added to the Results pane table. If you add average or median, it can be 
used as the benchmark in the Above and below benchmark comparison method.  

• In the Comparison method section, use the Comparison drop-down menu to select a method to 
compare locations and style the map accordingly.  

 

 
  



New comparison methods 
There are several comparison methods to choose from that style the map according to how values compare 
to one another. For instance, highlight extreme values in the data or use a color ramp to indicate high to 
low values. 
 

 
 
 

Results pane 

The results from the analysis are populated on the map and in the Results pane. The Results pane includes 
a summary, histogram, bubble chart or scatterplot, and a table.  

• The summary includes in-app documentation that provides definitions and visualizations for key 
statistical measures.  

• The histogram and bubble chart are an improved version of the Chart tab in comparison reports 
that provides more flexibility and uses the screen space more effectively. 

• The table can be expanded to help achieve the view that was used with the previous comparison 
reports. In the table, you can set the benchmark value and compare a location with other 
geographies.  

 
Hover over items in the Results pane to see corresponding features highlighted in the map. Change chart 
settings to customize results for your particular analysis. 
 

Summary tab 

On the Summary tab , use the Variable drop-down menu to select a variable to plot on box plots 
displaying minimum-maximum and outliers.  
 



 
 
Use the panel pagination to see a summary of the key statistics of the analysis, such as average, median, 
skewness, and kurtosis.  
 

 
 

In-app documentation 

To learn more about key statistics, click IQR, Skewness, or Kurtosis and read the definitions in the 
Overview of statistics window. Each definition includes charts to visualize the statistical measure.  
 

 
Histogram tab 

On the Histogram tab  , view the results for each variable in a histogram. 
 

 
 
  



Bubble chart tab 

On the Bubble chart tab , view the results as a bubble chart or scatterplot. 
 

 
 

Table tab 

On the Table tab , you can set a site or statistical measure as the benchmark and compare a site with 
other geographies. For table-focused goals, click Expand  to expand the table and cover the map. Use 
the Rows per page drop-down menu to select how many rows to display per page in the table. Click Next 
or Back to navigate the table pages.  
 

 
 

In the table, click the Options button   for a location to do any of the following: 
• Click Make benchmark to make that site or statistical measure the benchmark value. This is 

automatically used in the Above and below benchmark comparison method. 
• Click Compare with geographies to open the Geography comparison window.  
• Remove or replace a location in the analysis. 

 

 
 
  



Compare with geographies 

You can access the Geography comparison window in two ways: 
• In the benchmark comparisons workflow, click the Options button  and click Compare with 

geographies. 
• Click a site’s location on the map to use its pop-up menu. Select Comparisons and click Compare 

with geographies.  
 

 
 
 
In the Geography comparison window, you can compare a site or sites with different geographic levels 
and select variables from the data browser. 
 

 
 

Improved exporting to Excel 

The Export to Excel functionality is improved in the new benchmark comparisons workflow. The new 
exported spreadsheet includes a tab with raw data and a tab for each comparison method with color-coded 
shading. To access this functionality, on the Table tab of the Results pane, click Export to Excel to export 
the benchmark comparisons analysis into an Excel spreadsheet.  



 

Save layer 

With benchmark comparisons, customers can now save variables and sites together for later use! Just like 
with other redesigned workflows, there is the option to Save layer.  
 
Benchmark comparison layers are stored in the project pane, under Benchmark comparisons layers. To 
reopen the benchmark comparisons for editing, click the layer's Action menu   and choose Open 
benchmark comparisons. 
 

Set preferences 

To set preferences for benchmark comparisons, click My preferences . Expand the Maps section, 
expand the Run analysis section, and click Benchmark comparisons. You can set preferences to display 
certain featured lists, set default outline styling, and set a default comparison method to use in the analysis. 

 
 

Messaging 

If you click Comparison reports on the Reports tab, you will be directed to the new workflow with the 
option to take a guided tour. 
 

 
 

Custom and shared reports 

Previous custom lists and reports can still be accessed in the new benchmark comparisons workflow. If you 
saved a variable list in the data browser, it is available on the Shared lists tab when you add analysis criteria 
in the workflow. Customers will also see their additional saved lists in the My lists tab.  



 

 

Credits 

The main difference between the credit consumption of benchmark comparisons compared to the previous 
comparison reports is the ability to analyze more features at once. As a result, it is easier to consume more 
credits. It consumes 10 credits per 1,000 map requests using standard geographies or hexagons. 
 
 

Improved points of interest (POI) search workflow 
The points of interest (POI) search workflow is updated to provide a streamlined search experience, 
advanced search conditions, and enhanced styling options. 
 
Click the Enter category, keyword, etc. field and use the tabs to search by category, keyword, or code, 
and optionally add all points, add an advanced search, or browse saved searches. 
 



 
 
 

Add an advanced search condition 

An advanced search condition is a rule that prefilters your search results. This prefiltering provides more 
specificity to the search query. Since the number of points returned in a search is restricted to 5,000, it is 
useful to prefilter the search for refined results.  
 
Click the Advanced search tab and click + Add condition. Select a field to condition then choose a filter 
operator and set a value. Optionally, use condition groups for a more complex search. 
 

 
 
Use the is or is not filter operator to search for an exact match. New with this update is the ability to set 
multiple exact match conditions. However, when working with exact match operators (is and is not), 
additional conditions that are added will be limited to using the exact match operators. We are working to 
support a mixture of exact match and non-exact match conditions at a future release to make Advanced 
search even more flexible. 
 



New styling option for Places icons 

In the Style section, use the Places map style to apply unique point-based symbols based on location type. 
These new icons are the same icons used in the ArcGIS Places API. For this release, you can access the new 
Places map styling when working with Data Axle, SafeGraph, and Foursquare data sources. Additional POI 
data sources will have the new option available at a later release. 
 

 
 

Improved visibility for Search this area 

If you change the map extent during the workflow, click the Search this area pop-up on the map to refresh 
the analysis extent for your search. This option has been moved from the workflow pane to the map for 
better visibility and messaging. 

 

 

Save layer 

The saved layer can be accessed in the project pane in the Points of interest (POI) layers section for 
improved visibility and organization.  
 



 
 

Smart map search enhancements 

Show and style non-matching areas 

Smart map search has been enhanced to provide more flexibility in handling results for non-matching areas. 
Starting with the November release, users can view and style non-matching areas in their smart map search 
results by doing the following:  

• Click Show style options to change the fill and outline of out-of-range polygons. 
• Non-matching areas can be turned on or off in the Legend section with the Include non-matching 

areas toggle button. This has moved from the Results pane.  
 

 



Updated preferences 

To set preferences for smart map search, click My preferences . Expand the Maps section, expand the 
Create maps section, and click Smart map search. There are updated preferences for the following: 

• Add default map styling for non-matching areas.  
• You can also uncheck the setting Show instructional messages when workflow is run. This will 

allow you to skip the onboarding regarding filtering when the smart map search workflow is first 
launched.  

 

 
 

New guided tour step 

To help support the new functionality for non-matching areas, we have added a new step to the guided tour 
for smart map search. 
 
 

New infographics 
With this release, there will be several new Standard and Gallery templates. Standard infographics are 
unique, presentation-ready infographic templates that you can use to share key data indicators for a variety 
of purposes, audiences, and industries. Gallery infographics are templates designed for specialized goals, 
some of which use premium data sources from global partners such as Esri Japan and Esri France. These 
templates are open to enhancement based on feedback.  
 

New Standard templates 

Data source Title 
Esri 2024 K-12 Education Overview 
Canada Community Change Snapshot 

Demographic and Income 
Emergency Community Information 
Immigration, Ethnicity, Language (moved from Gallery) 
Infographic for Dashboards (Light) 
Work and Occupation (moved from Gallery) 
Community Demographics Report (updated from Community Profile) 



Infographics for Dashboards Dark (updated from Infographic for Dashboards) 
20 Year Population and Household Trends (updated from Population and 
Household Trends) 
Real Estate and Dwelling Report (updated from Real Estate) 
Visible Minority and Immigration (updated from Visible Minority) 

Esri India िहंदी बुिनयादी त� (Hindi version of Basic Facts) 

Global Spending Statistics (66 countries) 
Europe (Beta) Population and Spending Summary 

Europe Summary Report (Tabular) 
 

New Gallery templates 

Data source Title 
Esri 2024 Elections and Voting Overview (added in October) 

Transit Stop Analysis 
Dominant Urbanicity Type 

Canada Community Health 
Demographic and Income Report (Tabular) 
Market Profile (Tabular) 
PRIZM and Demographic Report (Tabular) 
Banking and Insurance Residential (updated from Financial and Spending) 
Market Area Analysis (updated from Market Area Report) 

Ireland Transit Stop Analysis 
 

Important changes 

Updated geography grouping  

When you set the geography for an analysis using Geographies, use the Group menu and select a list of 
grouped geographies (such as census geographies or school district geographies) and choose a 
geography level to map. The geography grouping is only available if you are using U.S. or Esri India data 
sources. It is available in the following workflows: color-coded maps, smart map search, suitability analysis, 
and benchmark comparisons. 
 



 
 

In-app glossary 

If you are using U.S. data sources, click View glossary in the Geography section of the following workflows: 
color-coded maps, smart map search, suitability analysis, and benchmark comparisons. This new in-app 
glossary provides definitions of the available U.S. geography levels and hexagons. 
 

 

Results pane enhancements 

The Results pane has been enhanced for ease of use and accessibility, especially when working with a 
larger amount of data in the Table tab. Expand the table for a larger view. Use the table pagination to 
navigate results. 
 

 
 



The enhancements to the Table in the Results pane are available in the color-coded maps, points of 
interest (POI) search, smart map search, suitability analysis, and benchmark comparisons workflows. 
 

Updated UI for Standard users 

Following the release, Standard users will see an updated interface that exposes Advanced features in the 
main workflow menus. These Advanced features will be greyed out with messaging for awareness. These 
updates are seen in the Add data, Run analysis, and Share results menus, as well as in the Geography 
card when hexagons are available for the workflow. 
 

Resources menus added 

In this release, we have added a Resources menu to all workflows launched from Create maps, Define 
areas, Run analysis, and Share results.  
 

 

New administrative preferences 

As an administrator, you can control whether project owners can share their projects with all members of 
the organization.  
 
Click My preferences . Expand the Organization section and click Projects. (This page was previously 
called Project attributes.) Use the Allow organizational sharing toggle button to turn organizational 
sharing on or off.  
 
When this option is disabled, users will only be able to share projects with individual members of the 
organization. The option to share projects with the entire organization will not be seen. 
 



 
 

Enhanced Business Analyst Assistant (Beta) capabilities 
Experience the AI-powered assistant's new capabilities, including smart map searching, site creation, color-
coded map enhancements, and docking.  
 
Note: 
To access Business Analyst Assistant (Beta), the ArcGIS Online administrator settings to enable beta 
features and AI assistant features must be turned on. 

 
New preferences 
ArcGIS Online has added a new setting to allow administrators to have greater control over access to AI 
assistants across all ArcGIS apps. This setting will be off by default and can be toggled to opt in. When this 
setting is turned off in ArcGIS Online, the assistant will also be disabled in Business Analyst Web App and 
cannot be turned on until the organization has opted in to AI assistants. 
 



 
Docking/positioning 

At the next release, you will see the assistant automatically docked to the right side of the app after 
generating results. Use the Display options to change the position from Docked to Compact or Floating. 
When using Compact or Floating, you can drag the assistant to your desired location on the screen. 
 

 
 
Find areas and create sites 
Business Analyst Assistant (Beta) is able to suggest two new workflows: smart map search and create sites. 
Use the Next button on the Assistant window and check out the new Create a site and Find areas 
prompts. The Create a site prompts suggest creating a map that highlights areas based on variable values.  



 
 

  



Honor user preferences for symbology 

When generating results through Business Analyst Assistant (Beta), settings in My preferences related to 
styling will now be respected. For example, set your point symbol and analysis extent styling preferences, 
then see it used when generating POI results through the assistant. 
 

Color-coded maps enhancements 

New capabilities for working with color-coded maps allow you to further customize your map directly 
through the assistant. After you have generated a suggestion, you can now change the variables directly 
through the assistant. Add or remove variables as needed using the + and x icons, then click Create map. 
You can also use the assistant to specify the color of the map when you are generating your initial 
suggestion or after the map has been created. 
 

Suggested topics for incomplete prompts 

When an incomplete prompt is entered, Business Analyst Assistant (Beta) will provide suggestions. Click a 
suggestion to generate results. 
 

New school district boundaries 
We have added three geography levels representing school districts. Look for the New label on these 
levels when accessed through relevant workflows.  
 

 
 
 
School district boundaries will be available in the following places: 

• Select geography 
• Mapping workflows found in Create maps and Run analysis menus 
• Boundaries and labels tool 
• Comparison workflows including infographics 

  



School district geography levels 

The definitions for the new school district geography levels are available in the in-app glossary. The 
definitions are as follows: 

• Secondary school districts  
o Secondary school districts (SD) are districts that are responsible for providing education to 

children in 6th or 7th grade through 12th grade. The Census Bureau categorizes school 
districts based on the grade ranges for which the school district is financially responsible. 
These may or may not be the same as the grade ranges that a school district operates. 
Source: U.S. Census Bureau/TIGER 2023  

• Elementary school districts  
o Elementary school districts (ED) are districts that are responsible for providing education to 

children in kindergarten through 5th or 6th grade. The Census Bureau categorizes school 
districts based on the grade ranges for which the school district is financially responsible. 
These may or may not be the same as the grade ranges that a school district operates. 
Source: U.S. Census Bureau/TIGER 2023  

• Unified school districts  
o Unified school districts (UD) are districts that are responsible for providing education to 

children of all school ages. In general, if there is a unified school district, there are no 
additional elementary or secondary school districts. Source: U.S. Census Bureau/TIGER 2023 

 

Onboarding 

When opening the Level of detail drop down for the first time after the November 2024 release, customers 
will see a coach mark to bring attention to the new options. 
 

 
 

Improved accessibility  
Delivering accessible software remains a top priority. The continued implementation of Calcite components 
leverage W3C Accessibility Standards to ensure the applications and experience is usable by a wide range 
of audiences.  
 



Efforts are made to enhance the accessibility of Business Analyst with each release to better support screen 
readers, improved keyboard interaction, visual display, high-contrast support, and other improved 
accessible functionality. You will see efforts for the November 2024 release throughout the application, in 
the reimagined benchmark comparisons workflow, enhancements to the points of interest (POI) search and 
smart map search workflows, in the pagination for tables, and in new infographics.   
 

Deprecation notices 

ArcGIS Community Analyst is being retired. The final planned release is November 2024.   

Community Analyst was originally designed as a community intelligence tool specifically for government 
agencies, policy makers, and civic organizations to better understand communities for policy planning and 
decision making. When Community Analyst was introduced fourteen years ago, it contained different data 
and workflows from ArcGIS Business Analyst Web App, but over time, the data and capabilities in both 
products have advanced and it is now redundant. Going forward, Esri will focus on development and 
innovation in Business Analyst. 
 
The final release of Community Analyst will be in November 2024. This will be the last release before the 
migration period begins on December 1, 2024, and it will include important functionality to enable the 
export of project content from Community Analyst into Business Analyst Web App. 
 
Customers should migrate to either Business Analyst Web App Standard or Advanced after December 1, 
2024. During this migration period, existing customers will receive renewal notices containing Business 
Analyst Web App Advanced, and user access to Community Analyst will be terminated upon license term 
end date. Customers will also have the option to move to Business Analyst Web App Standard. Stay tuned 
for more information and resources coming later in the year.   
 
We understand that this change may raise questions and we are here to support you. Should you have any 
questions or need assistance, please reach out to Esri Sales (1-800-447-9778) or your dedicated Esri 
account manager.  See Deprecation Notice for ArcGIS Community Analyst: Transition to ArcGIS Business 
Analyst Web App for more information. 
 

Updates to ArcGIS Experience Builder Business Analyst widget  
The updates to ArcGIS Experience Builder Business Analyst widget include: 

• The widget now supports drive-time options that allow travel modes and traffic selection when 
creating drive times.  

• Several bug fixes and minor enhancements. 
 

Updates to ArcGIS Business Analyst Mobile App 
The updates to ArcGIS Business Analyst Mobile App include: 

• You can add panoramic and 360-degree photos to your sites. However, these photo types cannot 
be created within Business Analyst Mobile App. To add a panoramic or 360-degree photo, use your 
device's camera app to capture the image, then open Business Analyst Mobile App and use the 
Photo Library or Browse option to add the photo. 

• View facts and run infographics and reports for school district boundary sites. 
• Access updated data for Canada, India (Esri India), and Michael Bauer Research countries and 

regions, global points of interest, and U.S. traffic counts.  
• Bug fixes and performance improvements. 

 



Blog article resources 
• What's coming in ArcGIS Business Analyst Web App (Nov 2024) 
• There are more blog articles to come on the new benchmark comparisons workflow, the updated 

points of interest (POI) search workflow, the Europe (Beta) data source, and more. 

https://community.esri.com/t5/arcgis-business-analyst-blog/what-s-coming-in-arcgis-business-analyst-web-app/ba-p/1551007
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